Exercise 1
Creating a presentation
Slide presentations are an effective means of sharing organized visual information. These presentations generally have two parts. One is the screen that everyone sees. The other is the speaker’s notes.

There are three primary ways to create presentations in CorelDRAW. The first is to create a full screen PDF. The second is to present directly in CorelDRAW, though, unless you have two monitors, you won’t be able to show your presentation completely full screen. The third is to create most or all of the graphics in CorelDRAW and export them to a dedicated presentation program like Corel Presentations or Microsoft PowerPoint. In this exercise, you will learn the basics of all three methods.
You can create your speakers notes in several ways. 

1. Create a paragraph text box just off the page in CorelDRAW

2. Place your notes on pages between the pages in CorelDRAW

3. Create your notes in any word processor

4. If you export the graphics from CorelDRAW, you can create the speaker notes in the Presentation program.

Even if you decide to use a dedicated program for your final presentation, creating the graphics in CorelDRAW gives you the advantage of being able to use all the tools to create graphics that are much different from the templates the presentation programs offer. This means that your presentations can stand out and be noticed from the crowd of presentations that all look just alike.

Step 1 – Create the Master Page

A master page contains all the design elements that will be shown on every page, such as the background, a logo, or a title. For this sample presentation, the only thing on the Master page will be the background.

Start a new document, letter sized, landscape orientation. This size and orientation will work for all three methods of presenting.

Double click the Rectangle tool to place a rectangle the exact size of the page into the drawing. Fill with a square two color fountain fill, keeping in mind the colors needed for the subject matter and presentation conditions. In the examples below, the rectangle is filled with a fountain fill from a dark green to a dark blue and has no outlines. The fountain fill settings are shown below:
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Since this particular sample presentation is going to have the subject of “Slide Presentations,” it will have a graphic that subtly echoes that theme.
[image: image1.emf]

Create a new rectangle which covers most of the bottom right of the page. Fill it with a slightly lighter shade of green than the green from the fountain fill. Round the corners of this rectangle and give it a Uniform Transparency with the starting transparency set to about 75 in the transparency property bar. Set the outline to NO outline.
[image: image2.emf]


This will be the area for the main content of the presentation. The transparency allows the blue of the fountain fill to continue into the area, while at the same time, subtly setting this part of the screen apart.

For a bit of interest, draw another rectangle about one inch high by 1.4 inches wide, filled with the same green and the same transparency as the rounded rectangle you just finished. You could even duplicate the rounded rectangle and resize it down, but you may want to round the corners more for the smaller rectangle. Give this smaller rectangle NO outline. Place this little rectangle so that the left sides of both the small rectangle and the large rectangle line up AND the center of the small rectangle aligns to the top of the larger rectangle. If you turn on Snap to Objects and Dynamic Guides, this will make the task very easy.
[image: image3.emf]


Duplicate that rectangle and align the duplicate with the right side of the larger rectangle.


[image: image4]
Switch to the Interactive Blend tool. Drag a line from the small rectangle on the left to the small rectangle on the right. Now, in the Property bar, reduce the number of steps to 3.
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Finally, select ALL the objects on the page, including the background rectangle, and group them.

In the Object Manager docker, click the Add New Master Layer (all pages) icon at the bottom left of the docker. Name your new Master layer Background. 

Still in the Object Manager docker, drag the group of objects from Layer 1 down and drop them into the Background master layer. Click the little pencil icon beside the Background layer to turn off editing for that layer. You don’t want anything you do from this point on to change that background layer.
Now you have a background that will appear on every page of your document.
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Step 2 – Create the content

For this sample presentation, there will be five slides – a title slide, an information slide with a bulleted list, a table of data, a slide with a pie chart, and a slide with a graph.

Add four pages to the document, for a total of five. Make sure the Apply Page Layout to All Pages icon is active in the document property bar (when no objects are selected) instead of the Apply Page Layout to this page only icon.
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As you add pages you will see that your master page layer is visible on all of them.

Once you have five pages, return to Page 1 by clicking on that tab.

The Title Page

There will be two parts to this title page to give you practice with some effects. On the left side of the page, there will be extruded text running vertically with a transparent fill. In the main section, there will be text with a drop shadow.
First create a new regular layer (NOT master layer) on Page 1. Rename it to Text.

With the text tool selected, type the word Across. Make a second text object and type the word DOWN. Both pieces of text should be Artistic Text. Make them a nice bold font like Arial Black.

The word Across should be about 45 pts. Fill it with orange just so that it contrasts well with the background and you can see it easily. Place it centered vertically in the area on the left between the main content area and the left side of the page.
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Now draw a vertical line right underneath the space after the R in Across. You can use almost any of the pen type tools to create this line. The two point line in CorelDRAW X6 is ideal for the task.
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Now select the word DOWN with the Pick tool. Go to the Text menu and choose Fit text to path. The mouse cursor will become a dark arrow. Point the point of the arrow at the line you drew and click to place the text along that line. The word has been filled with white in the illustration below to help you see it.
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In the property bar you should see the options for text on a path. In the first drop down, choose the bottom option in the list. This should make the letters in the word rotate to a vertical orientation.
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Switch to the Shape tool and click on one of the letters of the word DOWN without clicking on the line. Two large arrows should appear at the bottom of the word.
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Click the one on the bottom right a few times to space the letters out.
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Now you can see that these letters are a bit small to fit the space, so switch to the Pick tool and move the top of the D in Down up to just below the R in Across by grabbing the little diamond and dragging it up along the line.
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Change the font size to about 72 and give the letters a 2pt dark blue outline. Adjust the letters on the line again if necessary by dragging the diamond shaped control node by the D.
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Making sure you have BOTH the DOWN text and the line selected, from the Arrange menu, choose Break text apart. This will remove the text from the dependency on the path, but will keep it in its current orientation. Delete the line.
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Apply an Extrude to the DOWN text with a parallel back and the Vanishing Point only a very short distance from the center of the object. Use either the Interactive Extrude tool or the Extrude docker.
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Shown above is an extrude using the fill color. Change that to a shade from a dark blue to orange. Make sure there is no lighting turned on.
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Select the word “DOWN” with the Pick tool. In the Arrange menu, choose Break Extrude Group Apart. You will now have the front face separated from the extrude group. Fill just the face with orange and change the outline to orange. Give the face a uniform transparency with a setting of about 75 from the property bar. Set the transparency to make only the Fill transparent – the last dropdown in the transparency property bar. Change the outline of both face and extrude to a 4pt orange.
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Group the face with the extrude group so if you decide to move it, it will all move together.

Create another piece of artistic text in the main content area. Type the word Presentations. Use the same font you used for the other text on the page. Below, the font is Arial Black and is 72pts. Fill with orange, NO outline.
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Add a drop shadow. Start with the flat top right, then drag the shadow edge marker in closer to the word so the shadow echoes the direction and depth of the extrusion of the DRAW object.
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How this page actually appears will depend on your fonts, your settings, and to a certain extent, possibly the version of CorelDRAW you are using.
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Page 2

Click the Page 2 tab to go on to that page.

At the top of the page, using the same font you used on Page 1, in about a 42 pt size, type the words Things to keep in mind. Fill with orange and give it NO outline.
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Create a paragraph text frame inside the main content area by dragging with the text tool from near the top left to near the bottom right.
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This is where you will create your bulleted list. In that paragraph text frame, type the following lines of text:

Keep each slide simple.

Use only one or two fonts per slide.

Use large fonts so people can read.

Keep bulleted lists short.

Switch back to the Pick tool and change all the text to a thinner font than the title or less bold. Fill with orange and make it somewhere between 36-46pts depending on the font. All four lines should fit inside the text frame, though they may not all take up only one line.
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With the frame still selected with the Pick tool, click the Bullets icon in the property bar. This will add some small round black bullets by default.
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From the Text menu, choose Bullets… to get the bullets dialog. The Wingdings font is used by default for bullets, but you can choose from several symbol fonts if you have them installed on your computer. The Symbol dropdown will give you the list of possible characters to use in each font. This presentation uses Wingdings, but switch the symbol to a right facing arrow.

Increase the size of the bullet. The image below shows 50 pts, but use something that looks good with your text and font. Check Use hanging indent style for bulleted lists if you want the text lined up and the bullets outside the margins of the text.
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Bullets are inserted into text in the default text color for the document. Since the default text color was never changed from black, the bullets are black. Change the color of the bullets now by switching to the Pick tool, then click the orange well of the onscreen palette to fill them with orange.
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These bulleted points need a little space in between them, so select the frame with the Pick tool one more time. From the Text menu, choose Paragraph Formatting or Text Properties to open the docker. in the Paragraph section, increase the After paragraph to about 125- 150%. The idea is to put a bit of space between each bulleted item and the next, but still keep it all on the slide and as large as is practical.
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As you can see, the whole thing still looks rather busy, so you might want to follow the first and last principles of the list and delete the first one.
Here it is with only three bullets and 200% spacing between the paragraphs.
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The rule of threes states that people tend to remember things better when they are presented in sets of three, so the above list is probably better all around. This completes this slide.

Page 3

Before leaving Page 2, select the Guides layer in the Master Page area of the Object Manager docker. Pull a guideline down from the top ruler to the baseline of your title text on Page 2.

Go to Page 3. The guideline should still be visible. Using the same font and size text from the title on Page 2, type the new title for Page 3 – A Table of Data. Center it over the main contents area.
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In the main content area, create a table with four rows and three columns. Give the first row either no background or outline or a different background than the rest of the table. This is just a sample data table, so keep it fairly simple. An example is shown below.

[image: image34.emf]


You could also use a table created in another program and imported into CorelDRAW. These can usually be copied and pasted in as an OLE object and keep all their formatting from the other program.

Page 4
Go on to Page 4 once you have the table filled in on Page 3.

Title this page A Pie Chart in the same title font and size you used from page 2 and 3. If you were going to have a very long presentation, you might want to save the text Style. Styles work differently depending on the version of CoreDRAW. Check your help for information.
CorelDRAW does not have an automatic pie chart generator. You can have a spread sheet program generate one for you, then fancy it up in CorelDRAW, or for simple charts, you can create them yourself.

Start by drawing an ellipse with the Ctrl key held down while you draw to constrain the ellipse to a circle. Duplicate it once directly over the original by tapping the + key on your numeric keyboard or setting the nudge factor to 0 before duplicating by other methods. Fill the top circle with a different color than the bottom. With the top circle selected with either the Ellipse tool or the Pick tool, click the Pie icon in the Property bar. You’ll need to do a bit of math to figure out which degrees should be filled in to match your data. The sample pie chart below will show one large pie piece drawn from 0 degrees to 270 degrees and another (the bottom circle) from 270 degrees to 0 degrees to complete the pie.

Another way to create pie shapes is to use the Shape tool. Grab the main node of the circle and drag it around and IN to create a pie piece shape. Drag it around and OUT to create an open arc.

Once you have the pieces the size you want them, you can pull out one or more to emphasize your data.
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Use callouts or connector lines to label your data. Callouts are found in the Basic Shapes flyout and give you a closed shape that can be filled behind your text. Connector lines simply link to objects together, so you can use them to link a bit of text to one of your pie shapes.
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Make your pie chart more interesting by giving the shapes extrusions or drop shadows.
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Similar effects could be applied to bar charts as well.

Page 5

On page 5, place the title A Graph on your guideline in the same font, size, and color as the previous slides.

Graphs come in various forms, depending on the sort of data being related. You can often generate graphs of data in spreadsheet programs. You can then paste that graph into your CorelDRAW document. For simple graphs, it isn’t too hard to do directly in CorelDRAW. For this sample, draw a simple two axis graph with numbers from 1 to 5 along the vertical axis and letters from A-H along the horizontal axis.
First draw the two axes. Use the Freehand tool or Two-point line tool and click once at the top of the vertical axis, hold the Ctrl key and click again at the bottom of the axis where it joins the horizontal axis. Click again in the same bottom spot to start a new line segment connected to the old segment. Hold the Ctrl key down to constrain the line and place the last point for the horizontal axis.

To place the numbers, you can either use five separate text elements or use vertical text the same way you did for the Page 1 title.
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Obviously, if you are presenting real data, you will want to make the points along the line both meaningful and readable. The letters in the image above are 24pts in the original file. This is about as small as you will want to go so that your viewers will be able to understand your graph.

The data points do not have to be little circles. For this sample, use the polygon tool to create triangular points. Simply create one, then duplicate it and place the duplicate at the next data point. To get things lined up, you can either draw a grid with the graph paper tool having the same number of rows and columns as you have data points, or place guidelines to help you place your data on the graph. Once you have the data points in place, you can delete the grid and guidelines or you can draw in some lines if it will aid your viewers.
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To finish up the graph, connect the points to get your trend line. Probably the easiest tool to use for this is the Polyline tool. Simply click to place a point in the line, then click on the next point and the next until you have connected all the points. Finish with a double click.
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For a smooth curve between your nodes, select the line with the Shape tool, select all the nodes and convert to Curved segments and Smooth nodes. The line will now be a smooth curve.
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Within CorelDRAW, go to the View menu and choose Page Sorter view. In this view, you can see all the pages of your document and re-order pages by dragging and dropping them if that’s needed.

Turn off Page Sorter View.

When you are ready to do the presentation, be sure your pages are centered in the work window. Go to the View menu and choose Full Screen Preview. Navigate through your presentation by tapping the forward and back arrow keys on your keyboard.
You can also publish to a full screen PDF for the web. In the File menu, choose Publish to PDF. Choose Web as the PDF preset in the dropdown. Give your presentation a file name and choose where to place it, then click the Settings button on the bottom right of the dialog. On the Document tab, instead of Page Only, choose Full Screen. OK and then Save. To view the file, open it and view in Full screen mode if it does not come up in that mode automatically. Simply click anywhere to page through the presentation or use the forward and back arrow keys on your keyboard. To exit full screen mode, tap the Esc key.
Finally, you can export the graphics you have created to another program to use.
